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[bookmark: _Toc184241288][bookmark: _Toc184241533][bookmark: _Toc184241580][bookmark: _Toc184242068][bookmark: _Toc187615330]Introduction
Your thesis consists of a title page, info page, visual abstract (when needed or desired), table of contents, chapters, references, and appendices. This thesis template is a basis and provides guidelines for formatting all these components and the thesis as a whole. As formatting makes up of 25% of Your thesis assessment, You should allocate sufficient time for it.
This document includes guidelines for formatting in Microsoft Word. The use of that software is not mandatory, but it does provide You with tools for correct formatting. In accordance with Your own wishes, You can use other text editors such as Apache OpenOffice Writer or Pages. You can also create and format Your thesis with LaTeX. There is a separate template for that. When making Your thesis draft with Your supervisor, You might have used Google Docs software. While Google Docs is an excellent tool for collaborative work, it does not have the tools for correctly formatting Your thesis. Thus, when You have reached a point in Your thesis writing when it is time to format a fair copy from Your draft, You should use sufficiently capable software packages.
The template provides instructions and guidelines related to the different components of Your work. The contents of this template are meant as recommendations that will help You format Your thesis. Specific rules, also those regarding the formatting, are written in the Guidelines for preparing and grading of graduation theses at the Institute of Computer Science of the University of Tartu document. The latest version of that is available on the webpage of the Institute of Computer Science: https://cs.ut.ee/en/content/thesis-deadlines-and-guidelines 
In addition to formatting, this template also provides recommendations regarding the contents of different sections of Your thesis. Regarding the thesis contents, You should also refer to the institute’s official guidelines document. Hopefully the recommendations here also help You write Your thesis better.
The Introduction chapter should open Your thesis topic and explain its relevance (implicitly tell the reader why they should continue to read Your work). After opening the topic, You should explain to the reader what Your thesis offers to the world, what issues it is solving, or what questions it is answering. From the Introduction, it should be obvious what goals You had to make Your thesis. Then, either at the end of the Introduction or weaved into the chapter itself, there should be a brief overview of all the content chapters. The corresponding content chapters must be cross-referenced when described.
The length of the Introduction chapter depends on the complexity of the work. Typically, for a bachelor’s thesis, a single page is sufficient to describe to the reader the importance of the topic, the goal/contribution of the work, and the contents of the thesis. For a master’s thesis, several pages are typically needed, as the topics are more complex and need lengthier explanations. Technically, You can add subchapters to the Introduction, but that is generally not very useful. Ideally, Your Introduction chapter should be the same length as the Conclusion chapter, and they should go together with each other (reading sequence of the Introduction and then the Conclusion, the reader should already get a very good overview of Your work). It is understandable that You wish to explain Your field to the reader more thoroughly – to give the reader all the prerequisites to understand Your contribution. For that, it is good to use the subsequent main chapter right after the Introduction. When it comes to the introduction chapter itself, try to keep it below a few pages in length, introductory, and on-point.
In chapter 2 this thesis template describes aspects of formatting the thesis and offers recommendations. It covers different components of the thesis, from the entire thesis structure to the thesis elements and references. For each component, the template presents important things to consider when formatting that component. Chapter 3 subsequently provides guidelines related to text creation, such as the use of generative artificial intelligence.
The template is structured similarly to a thesis. When using this template to format Your fair copy, delete all the current content and replace it with the content You have created in Your draft document. The replaced content should be virtually finished content. If it is subject to changes, the formatting work could need to be redone.

[bookmark: _Ref184346282][bookmark: _Toc187615331]Formatting
Many different tools, some of which You might not even be aware of, will be used to format Your thesis. As good formatting makes up 25% of Your thesis grade, it is important to take it seriously and allocate sufficient time. Especially if You have not previously formatted documents of that size that well or learned the use of corresponding tools. This chapter looks at the formatting principles for different parts of the thesis.
[bookmark: _Toc187615332]The Title and Info Pages
The very first page – the title page – is already formatted in this template. The title page must include the curriculum You plan to graduate from (including the educational institution and the institute), thesis title, kind and volume corresponding to the level of studies, Your name, the names (and, optionally, the academic degrees) of Your supervisors, publication location, and year. On the title page, the places You need to change to correspond with Your thesis are marked with a yellow background. Remove the yellow background after filling in your information. Be sure to check the corresponding information. For example, if You decide to add the academic degrees of Your supervisors, check if an abbreviation is MSc (Master of Science) or MA (Master of Arts). The degrees differ depending on the curricula.
The info page, which follows Your title page, includes the abstract, keywords, and CERCS codes of Your work. The abstract should give an overview of everything done during Your work. For example, if three of Your content chapters thoroughly describe the different processes and results of Your work, then that should be readable from Your abstract. Concentrate on mentioning in the abstract what You did that can be read about in the thesis.
Keywords are the different terms and names that designate important aspects of Your work. To come up with keywords, You should think about Your work generally. What important terms come to Your mind if You think about Your work as a whole? For inspiration, it is good to check out the keywords of previous theses made on similar topics. Figure 1 shows the word cloud of keywords from the theses defended at the Institute of Computer Science in 2015–2020[footnoteRef:2]. [2:  https://cglearn.eu/theses/top ] 

[image: ]
[bookmark: _Ref185616715]Figure 1. The word cloud of keywords from theses defended at the Institute of Computer Science in 2015–2020.
Besides the keywords, You also need to assign a Common European Research Classification Scheme (CERCS) code to Your work. These codes classify research areas. Often, it can be hard to classify a thesis using a specific classifier. Still, You must find a classifier that Your work fits under the best. You can use several CERCS codes. The classifiers are on the Estonian Research Information System’s web page: https://www.etis.ee/Portal/Classifiers/Index/26.
After the info page, You can also add a visual abstract to Your work. That will be a single figure that efficiently describes the process and results of Your work. The figure has to include the information listed in the Guidelines for preparing and grading of graduation theses at the Institute of Computer Science of the University of Tartu document. When using the institute’s logo, respect its protected area – it must have the height of the house of free space around it. The visual abstract is helpful to add, as it quickly conveys the nature of Your work to the reader. You can reuse the graphics later on Your defense slides and when popularizing Your work.
[bookmark: _Toc187615333]Structure
It is essential for the reader of Your work that Your document is structured logically and clearly. Good titles and reasonable content sectioning to chapters and sub-chapters guide the reader through Your thesis.
[bookmark: _Toc187615334]Titles
Both the thesis title itself and the chapter titles should be concise and on-point. Long titles could carry too many ideas within themselves, and You can lose Your reader already at the title. The main title of the thesis should maximally fit on two lines.
In English, the words in titles start with capital letters. There are different styles, but generally, all the words besides pronouns should start with a capital letter. It is good to use the Capitalize My Title tool: https://capitalizemytitle.com/.
In Estonian, however, only the very first letter of the title is capitalized, and the rest of the words are written just like regularly.
Punctuation should be avoided in titles. Depending on the nature of Your work, an em or en dash could be reasonable. For example, if You have created a software product, it is good to mention the product's name in the title, followed by a longer dash and a description of its unique value. On the other hand, a sentence with commas or question marks would not fit as a title.
These principles also apply to the titles of Your chapters, which are called headings. The content chapter headings start with numbers. It is up to You if You start the numbering from the Introduction chapter and end it with the Conclusion chapter or leave these two chapters unnumbered. In this template, the Introduction and Conclusion chapters are also numbered. The Conclusion chapter is followed by unnumbered sections called References and Appendices. For different appendices, it is reasonable to use some numbering again. To number the appendices, You can use Roman numerals (Appendix I, Appendix II) or capital letters (Appendix A, Appendix B). 
The subchapter numbering includes the number from the parent chapter. For example, the subchapters of chapter 2 are numbered 2.1, 2.2, etc. The dot mark after the entire numbering is used only in the first-level headings. Starting from the third-level headings, the numbering can be omitted. In this template, the heading styles (Heading 1, Heading 2, etc) are configured to use automatic numbering.
[bookmark: _Toc187615335]Table of Contents
At the beginning of Your work, after the info page and visual summary, but before the first chapter, there is the Table of Contents. Capable text editing software generates the Table of Contents automatically. It is also automatic in this template. The Table of Contents is generated from the titles using the heading styles (Heading 1, Heading 2, etc). It is important that the title of the table of contents or sections beforehand do not use these styles because these headings must not be in the Table of Contents. In this template, the Unlisted Heading style exists for these headings.
[bookmark: _Toc187615336]Text
The alignment of the thesis text must be justified (straight rug from both left and right). Justified alignment can create a situation when the spacing between words in one line is visually too much. In such cases, the line can be hyphenated to fix the visually bothersome spacing. Many text editors have automatic hyphenation capabilities, but these are prone to over-hyphenation. Having hyphenated words hinders the readability of the text, so hyphenation should be used minimally. One should avoid situations when multiple subsequent rows are hyphenated.
The guidelines for preparing and grading of graduation theses at the Institute of Computer Science of the University of Tartu document presents many text formatting rules. For example, the line spacing of text should be in the range 1.0-1.5. This template uses 1.5.
It is possible to use italics, bold, or other text formatting tools to emphasize some terms or ideas in Your text. However, it is good to use these tools sparingly so as not to make Your work visually too hectic.
When writing paragraphs, You should observe that there would not be a single lone word at the last row of the paragraph. This is called an orphan word, and it is not visually very good. Checking for orphan words or lines (an orphaned line of text at the beginning of a page that is followed by a new chapter or empty page) is something one should do as one of the last things when formatting their fair copy.
[bookmark: _Toc187615337]Elements
Many different elements like figures, tables, and code examples improve the appearance and reader’s understanding of Your thesis.
[bookmark: _Toc187615338]Figures
All the different images, be they plots, photographs, or screenshots, are labeled as figures. When adding an image, it should be labeled as a figure, numbered, and captioned. In Microsoft Word, You right-click on the image and choose Insert Caption (see Figure 2). In the pop-up window, You choose the label as Figure (or create such a label if it is absent). The captions of figures are always placed right below the figure (see Figure 3).
[image: ][image: ] 



[bookmark: _Ref185620517]Figure 2. The button to insert a caption in the image’s context menu.
[bookmark: _Ref185620651]Figure 3. The pop-window for adding a caption.



[image: ]Then, a short description caption should be written. It should be clear from the caption what is depicted in the image. The caption is written in a separate text box if the image is wrapped. The caption should be visually closer to the image than to the subsequent thesis text. The Caption style in this template adds more margin below the caption than above.
The correct wrapping of an image is very important for its placement. You can add the images in the middle of the page or wrap text around them. The wrapping options open from an icon shown next to a selected image (see Figure 4).
It is recommended to wrap the text around the image in situations where the image is about 1/3 of the width of the page. In other situations, it is likely better to have the image in the middle of the page without text wrapping.[bookmark: _Ref185620972]Figure 4. Wrapping options.



When positioning the images, You have to be very careful not to scale the image unevenly. Both the vertical and horizontal scale of the image must change the same proportion. Typically, when You scale an image from the corner (not from the edge), it scales evenly. In some software, You might need to hold either a Shift or Ctrl key. Not accounting for even scaling creates unevenly stretched images and is very bad.
We recommend creating a solid color palette when creating images. This means that You use the same colors (or course with the same semantics) for plots throughout Your thesis. A useful tool for creating a color palette is Coolors: https://coolors.co/generate. Depending on the situation, You need to consider that the chosen colors support the readability of Your plots. For example, You should not pick two very similar colors to represent different data points. Tamara Munzner has presented principles about data visualization in her talk Keynote on Visualization Principles [1]. A good and cohesive color palette and style are crucial not only for plots but also for graphical elements added to screenshots or for figures in general.
[bookmark: _Toc187615339]Tables
A thesis can also include tables, in addition to figures. When adding tables, You should consider that reading very large tables is difficult and perhaps the data within them should rather be visualized on a plot. However, sometimes, it is important to represent the data as a table. Smaller tables can fit very nicely into the contents of a thesis. Larger tables can be added in the appendices (either in the Appendices section or as a file in the Accompanying Files archive).
The recommendations for figures are also the same for tables. The only difference is that the caption of a table goes above the table (the caption of a figure was below). For example, look at Table 1. In this template, the captions of tables have a style Table Caption because there should be more space above the caption than below it.
[bookmark: _Ref185622162]Table 1. The differences in formatting figures and tables in a thesis document.
	
	Caption Placement
	Content

	Figure
	Below
	Images, graphs, photographs, screenshots

	Table
	Above
	Data

	Code
	Below or absent
	Program code, psudocore


It is reasonable to use 1.0 line spacing for the contents of a table. Otherwise, the contents will not be vertically aligned within table cells. When formatting tables, it is, again, very good to use a cohesive visual style and colors. You should also choose what kind of text formatting You want to use for tables. For example, in Table 1, an 11pt text size is used, while the rest of the template text is 12pt.
[bookmark: _Toc187615340]Code Examples
When You bring examples of program code, You should use a monospace font. Examples of these are Consolas and Courier New. You should pick one and use it cohesively throughout Your thesis text.
The formatting of code examples is not as regulated as figures and tables. Brief code examples can be written inside paragraphs. For example, one can write that declaring a variable and assigning a value can be done with code var a = 10;. For longer code examples, You should create a separate block with the Code Block style in this template. For example:
function add(a, b) {

    return a + b;
}
The Code Block style adds a border around the paragraph containing the code example and uses a monotype font. You can also color Your code (for example, use a tool that will automatically color it) to be easily readable. The text surrounding the code block must address the code example in a sufficiently clear and helpful manner.
[bookmark: _Toc187615341]Mathematical Equations
Formatting mathematical equations is somewhat more complicated than the previously described elements. The mathematical equation must be entered with the Insert → Equation tool. The equation can be added inside the paragraph. For example, an equation for adding values is . For bigger and citable equation, the equation must be added to a new line. On that line, make two tabulation markers by clicking on the ruler above the page. One of the markers must be center-aligned (double-click on the marker allows to configure this), and the other must be right-aligned. This technique allows You to add an equation to the center of the page and the number of the equation to the right.
Under the right marker, You can add the number for the equation with the References → Insert Caption tool. Use the Equation label. Then You must also check the Exclude label from the caption checkbox because that gives us the number only (1, not Equation 1). This is the number that can thereafter be referenced from the text. Unfortunately, the brackets around the equation number must be entered manually in Microsoft Word. For example, equation 1 in this template is formatted in that way.
[bookmark: _Ref184319268]		(
[bookmark: _Ref185624527][bookmark: _Ref184319024]1
)
It is possible that when adding the cross-reference, the entire equation ends up in the cross‑reference. In such a case, the caption number must be surrounded by style break symbols that can be added via Ctrl + Alt + Enter[footnoteRef:3]. These hidden symbols look like paragraph-end symbols ¶ but also include a dotted line around them. An alternative solution is to use an invisible table to align the equation and its number correctly. It is important that the equation itself be in the center of the page and the cross-referencable number on the right. [3:  https://answers.microsoft.com/en-us/msoffice/forum/all/how-do-i-insert-equation-references-without-word/a78db062-497a-e011-9b4b-68b599b31bf5 ] 

[bookmark: _Toc187615342]References
Correctly citing Your sources is very important in Your work. Failure to do so may result in academic fraud, which can cause Your thesis to get a negative review. This template explores three types of references. These are the cross‑references between the different elements of the thesis, the footnote references for the so‑called weak external references, and the main references, which are also called strong references.
[bookmark: _Toc187615343]Cross‑References
All the figures, tables, and mathematical equations must be cross‑referenced from the text. The purpose of that rule is to ensure that the illustrative elements actually support Your content.  The added element must be connected with Your text and cross‑referenced in a suitable place. Cross‑referenced can be created with the References → Cross-reference tool. In the opened window, You can choose the element’s type to cross‑reference. The reference should include the label and the number, but typically not the whole caption. The cross‑reference turns into a link (that remains when exporting a PDF). This means that the reader is taken to the referenced element when they click on the cross‑reference.
Sometimes, You might want to change the label of the reference. Because the reference labels are generated automatically, they will be overwritten when the document is updated (which happens, for example, when generating a PDF). This means that You should not just change the label text of the cross‑reference. When that is really needed, the corresponding cross‑reference must be locked by pressing Ctrl + F11. This turns off automatically updating the selected label of the cross‑reference. For example, when You have changed and locked the cross‑reference in the text „see Figure number 1“ (by default, the cross‑reference would just be „Figure 1“), and now proceed to add a new figure in the front, then the new figure would get the number 1 thus Your locked cross‑reference text would have an incorrect number. This means that locking and changing the cross‑reference texts must be done very carefully and as one of the last things when formatting the document.
[bookmark: _Toc187615344]Footnote References
The external references can be called as weak and strong. This does not mean anything about their influence or usefulness to Your work. For some external sources, You must make a subjective decision if the reference will be rather the so-called weak or strong one. Weak references are, for example, references to Wikipedia pages, Stack Overflow posts, webpages of products, dictionaries, and private communication, where the referenced source is not a solid publication by a clear author. Generally speaking, all sorts of web references are usually weak references. However, a web reference to a blog post by a reputable author can be considered a strong reference.
The weak references should be formatted as footnote references. To create that, choose the References → Insert Footnote tool, and copy-paste the link into the footnote. For such references, it is not important to find the author (for example, with product websites, software documentation, or Wikipedia articles, it might not even be an easily deducible author). Typically, it is sufficient to add the link to the website where You got the cited information. 
Such footnote references are very good, but in addition to those, Your work should be based on an adequate number of strong or main references.
[bookmark: _Toc187615345]Main References
In this template, the main references are such references that go to the References section at the end of Your thesis. That section is sometimes titled „Cited Literature“ or „Used Sources“. The strong references that go there are typically reputable publications by specific authors. For example, scientific papers, books, conference presentations, and theses, but these can also include blog posts or news articles. You should have a sufficient amount of strong references depending on the level of study that You are writing a thesis on. It is hard to say a specific number because it will depend on the nature of Your work, the quality of Your references, and how thoroughly You have used them. However, just two strong references would undoubtedly be too few for any level.
There are different reference styles commonly used in different fields. In Your thesis, You can pick a style that You prefer. In computer science, the ACM and IEEE numeric styles are common. In these styles, the source numbers are inside square brackets (for example, „[1]“, „[2]“, and so on), and these are used to reference a source in the text. In mathematics, the AMS trigraph style is popular. In that style, the square brackets contain the first letters or initials of the authors and part of the publication year (for example, „[Mun12]“). In social sciences, the popular style is APA, where the source is referenced by the author’s name and year in round brackets (for example, „(Munzner, 2012)“).
There are three options to format the references. First, You can find the rules for the preferred reference style (ACM/IEEE, APA, etc.) and create the references section manually. Secondly, You can use the Bibliography tool, which is built into Microsoft Word and can be accessed from the References menu. The easiest third option is to use an external tool such as Zotero[footnoteRef:4]. [4:  https://www.zotero.org/ ] 

Zotero allows You to easily manage references and data about them (including files and Your notes) in Your personal database in the Zotero desktop application. When writing Your draft in Google Docs, You can already use Zotero to add and format the references in the correct place. When moving to Microsoft Word, You can use the corresponding plugin that adds a Zotero menu to Word. The plugin allows You to search and add references from Your personal database and, afterward, with a single click, create and correctly format the References section. Among other styles, Zotero includes the IEEE/ACM and APA styles. However, the AMS trigraph style is missing at the time of creating this template[footnoteRef:5]. Furthermore, Zotero is currently not able to create hyperlinks from the links in references[footnoteRef:6]. Still, when You export the PDF file from Microsoft Word, PDF readers usually recognize links and can hyperlink them themselves. [5:  https://forums.zotero.org/discussion/107971/computer-graphics-forum-eurographics-citation-style ]  [6:  https://forums.zotero.org/discussion/76312/csl-style-with-doi-hyperlinks ] 

The referenced scientific papers usually have Document Object Identifier (DOI) numbers. Specific DOI links[footnoteRef:7] (in the form doi.org/[number]) are generated from these. When referencing scientific papers, it is recommended to add the DOI links to the reference without the access date. When adding source links, ensure the links are correct and working. When You use the university proxy to access the papers, Your links directly on the browser’s address bar could be proxy links. Do not copy these into Your thesis. Ensure that Your reference links are clean and working, and, when possible, prefer the DOI links. [7:  https://dx.doi.org/ ] 

[bookmark: _Toc187615346]Appendices
The Appendices section in Your thesis follows the References section. In that part You can present larger tables or screenshots that do not fit in the main contents. Often, it is reasonable to present Your Glossary to define the jargon terms used in Your thesis. If You have created software during Your work, the Appendices section can also include the installation instructions and user manual. The section can be subsectioned and numbered in Your preferred way. For example, Appendix I: Glossary or Appendix B – User Manual, etc. There are many guides to creating a good user manual, but one example of writing technical texts is the textbook „A Strategic Guide to Technical Communication“ by Graves and Graves [2].
One very important appendix is the description of the accompanying files. Together with the thesis document, You can also add an archived file. That archive file usually includes longer texts (for example, if Your user manual is very long, You need to include longer license texts for the user assets, the questionnaire used in Your study, etc.), larger files (for example, the measured raw data, their analysis files, audio and video recordings of the software or its testing, etc.), the created software, its source code, design concepts and other files created during Your work. Use one of the appendices to describe the contents of the accompanying files.
[bookmark: _Ref185607096][bookmark: _Ref185607101][bookmark: _Toc187615347]License
After the Appendix section, at the end of Your document, You must add a license to allow the  University of Tartu to store and distribute Your thesis. The text of that license is updated often and depends on whether Your work is classified or not. The newest texts are at the URL: https://adr.ut.ee/?page=pub_list_dynobj&desktop=57835&tid=70993&data_only=true&search=Otsi&field_100193_search_type=ANY&field_100193_text_search_value=ppimine.
The link above has the non-exclusive license as document number 30. In most cases, that license should apply to You. When Your work includes information that must not be published during some timeframe or even indefinitely, You need to write a corresponding application to the vice dean for academic affairs to use a limiting license. The application is in document number 32, and when the vice dean of academic affairs has approved Your application, You can use the corresponding limiting license from document number 31.
[bookmark: _Toc187615348]Metadata
Your thesis file includes metadata – data about the file itself. You can see and edit that when You choose File → Info in Microsoft Word. The most important fields to fill out are the Title and Tags. Write the title and keywords of Your thesis into those.
[image: ]
Figure 5. The metadata for the title and tags.
It is recommended that You check through the rest of the metadata to ensure it is all good. For example, it has happened that the author of the file has not been the author of the thesis. This kind of contradiction creates suspicion about who has really authored the thesis document.
[bookmark: _Ref184346299][bookmark: _Toc187615349]Text Creation
By the time You start using this template, You have likely completed its contents using a more comfortable and collaborative software like Google Docs. Starting formatting makes sense only when the contents of Your work no longer change much. Otherwise, the changes in the content may require doing the formatting part again. Still, some formatting-related recommendations are relevant a lot earlier than when formatting the draft to a fair copy.
[bookmark: _Toc187615350]Chapters
Your thesis chapters should be evenly balanced with each other. Because this template focuses on formatting, then that guideline is broken here (the previous chapter 2 is noticeably lengthier than this chapter 3). In Your work, all the chapters besides the Introduction and Conclusion should have a relatively even length. This principle also helps You not overdo a single part of Your work but spread Your attention to all the essential parts. What precisely these parts are depends on Your thesis type. The University of Tartu’s Institute of Computer Science’s thesis preparation and grading guidelines document defines a certain number of these types. The study or research group where You are doing Your thesis might define continuations of those types. Ensure that Your thesis document provides a balanced coverage of all Your chosen thesis type requires.
By the time Your thesis starts to take shape, it is useful to look at Your document as a whole. In Microsoft Word, You can do it by choosing the View → Multiple Pages tool and zooming it out. This view will give You a birds-eye overview of Your document. Just like if You would have printed out all of the pages and spread them across a desk. From that view, You see if all the different parts of the document are balanced and in visual equilibrium (see Figure 6)

[image: ]The birds-eye view of the thesis also shows You if all the necessary places have text. For example, every chapter should start with a brief introductory text. This text must be after the heading and before any subheadings. That introductory text usually explains why the corresponding chapter is necessary for Your work and what the reader can expect from the subchapters. In addition to that, the (sub)chapters could be woven together with connective sentences, and every bigger chapter could end with a conclusive paragraph. No chapter should start or end with any elements (figures, tables, code examples, equations) or a list. Your thesis text must be smooth to read.[bookmark: _Ref186082759]Figure 6. The thesis template visualized as a whole.

[bookmark: _Toc187615351]Spell Checking
Microsoft Word’s speller, which You should turn on, comes in really handy when formatting Your fair copy. Having worked on Your draft a lot, You might have gotten used to looking at the same text over and over again; thus, noticing spelling mistakes Yourself might be quite difficult. There are spelling and proofing tools in Word for both the Estonian and English languages. Presenting a thesis that has grammatical errors can result in a lower grade.
Of course, You are also free to use tools that provide grammatical assistance, such as Grammarly, if You have access to such tools, and they make Your work more effective.
[bookmark: _Toc187615352]Using Generative AI
Using generative AI tools can also make Your work more effective. Here, their use for purely text editing purposes is focused on. When You have also used generative AI for content-related purposes (for example, to create Your questionnaire questions), You should definitely detail Your generative AI usage within the contents of Your thesis text. However, using it for editing Your thesis text is not content-related, so it will suffice to mention its use at the end of the Introduction chapter.
One good way to use a generative AI chatbot is to give it a paragraph of Your text and a prompt to make the specified academic text more readable. When doing that, You should read the result and correct it as needed. The AI chatbot might have mutated Your thoughts in the text, and You must restore them. Also, You might not personally agree with the specific style that AI has provided You and may want to keep tweaking it. The generative AI tools can very effectively help improve Your text flow, but You have to be very keen to ensure that the modified text still conveys Your thoughts and that You agree with the proposed writing style.
It is certainly not effective to use paragraphs that are solely generated by AI in Your thesis text. The author of the thesis is still You. This means that You are responsible for what is written in Your document. Typically, the text written by AI tends to be too general, overly illustrative and includes factual errors that a knowledgeable human author would not make. You do not want to put Yourself into a situation where You have to direct blame towards an AI chatbot due to issues in Your thesis text.
[bookmark: _Toc187615353]Conclusion
This thesis template has given an overview and recommendations on various formatting and text creation techniques. For specific rules, it is useful to see the Guidelines for preparing and grading of graduation theses at the Institute of Computer Science of the University of Tartu document. Although this template focused on Microsoft Word software, the formatting rules and recommendations also apply to other capable text editors (for example, OpenOffice Writer, Pages, LaTeX, etc.). When creating a fair copy from Your draft, ensure that Your chosen text editor includes all the necessary tools. For example, Google Docs is not suitable for that work as it is missing several required tools presented in this template.
When formatting Your thesis, look at Your thesis document both as a whole (structure, balance, visual style) as well as individual components separately (info page, content elements, references, metadata). The different parts of Your work need different approaches. For example, to format the main references effectively, an external tool like Zotero might be useful. Formatting means not only positioning and cross-referencing an element but also the formatting of the element itself. For example, the plots in Your thesis must be well-designed and neatly formatted, just like the thesis itself. It is crucial to allocate enough time to study the tools and techniques to format Your thesis thoroughly.
Hopefully, this template helps You. To use this template, make a copy of it and delete or substitute all the content text. The pre-configured text styles should help You format Your draft to a fair copy. Certainly, look over Your document’s metadata and ensure they correspond to Your real thesis contents. Your supervisor can also be very helpful when it comes to thesis formatting. So, be active in asking them for help. Good luck with this last graded 25% You do before submitting Your Thesis!
[bookmark: _Toc187615354]References
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[bookmark: _Toc187615355]Appendices
You can make separate sub-sections here for Your glossary, description of accompanying files, user manual, large pictures, and tables.

[bookmark: _Toc187615356]License
To here You must add a license that allows the University of Tartu to store and publish Your thesis. The newest license texts can be found at the following address:
https://adr.ut.ee/?page=pub_list_dynobj&desktop=57835&tid=70993&data_only=true&search=Otsi&field_100193_search_type=ANY&field_100193_text_search_value=ppimine 
Please read chapter 2.7 in this template to know what license You have to use on this page.
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